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Please observe the following notes

User group of this manual

The use of products described in this manual is oriented exclusively to:

– Qualified electricians or persons instructed by them, who are familiar with applicable 

standards and other regulations regarding electrical engineering and, in particular, the 

relevant safety concepts.

– Qualified application programmers and software engineers, who are familiar with the 

safety concepts of automation technology and applicable standards.

Explanation of symbols used and signal words

How to contact us

Internet Up-to-date information on Phoenix Contact products and our Terms and Conditions can be 

found on the Internet at:

phoenixcontact.com

Make sure you always use the latest documentation. 

It can be downloaded at:

phoenixcontact.net/products

Subsidiaries If there are any problems that cannot be solved using the documentation, please contact 

your Phoenix Contact subsidiary. 

Subsidiary contact information is available at phoenixcontact.com.

Published by PHOENIX CONTACT GmbH & Co. KG

Flachsmarktstraße 8

32825 Blomberg

GERMANY

Should you have any suggestions or recommendations for improvement of the contents and 

layout of our manuals, please send your comments to:

tecdoc@phoenixcontact.com

This is the safety alert symbol. It is used to alert you to potential personal injury 

hazards. Obey all safety measures that follow this symbol to avoid possible 

injury or death.

There are three different categories of personal injury that are indicated with a 

signal word.

DANGER This indicates a hazardous situation which, if not avoided, will 

result in death or serious injury.

WARNING This indicates a hazardous situation which, if not avoided, could 

result in death or serious injury.

CAUTION This indicates a hazardous situation which, if not avoided, could 

result in minor or moderate injury. 

This symbol together with the signal word NOTE and the accompanying text 

alert the reader to a situation which may cause damage or malfunction to the 

device, hardware/software, or surrounding property.

This symbol and the accompanying text provide the reader with additional 

information or refer to detailed sources of information.
PHOENIX CONTACT

DOWNLOADED FROM WWW.SCATTS.CO.UK

http://phoenixcontact.com
http://phoenixcontact.com
http://phoenixcontact.net/products


Please observe the following notes

DOWNLOADED FROM WWW.SCATTS.CO.UK
General terms and conditions of use for technical documentation

Phoenix Contact reserves the right to alter, correct, and/or improve the technical 

documentation and the products described in the technical documentation at its own 

discretion and without giving prior notice, insofar as this is reasonable for the user. The 

same applies to any technical changes that serve the purpose of technical progress.

The receipt of technical documentation (in particular user documentation) does not 

constitute any further duty on the part of Phoenix Contact to furnish information on 

modifications to products and/or technical documentation. You are responsible to verify the 

suitability and intended use of the products in your specific application, in particular with 

regard to observing the applicable standards and regulations. All information made 

available in the technical data is supplied without any accompanying guarantee, whether 

expressly mentioned, implied or tacitly assumed. 

In general, the provisions of the current standard Terms and Conditions of Phoenix Contact 

apply exclusively, in particular as concerns any warranty liability.

This manual, including all illustrations contained herein, is copyright protected. Any 

changes to the contents or the publication of extracts of this document is prohibited.

Phoenix Contact reserves the right to register its own intellectual property rights for the 

product identifications of Phoenix Contact products that are used here. Registration of such 

intellectual property rights by third parties is prohibited.

Other product identifications may be afforded legal protection, even where they may not be 

indicated as such.
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1 Basics and example project

1.1 Information about this document

This document describes specific features associated with the startup of Axioline E 

PROFINET IO-Link devices on a Phoenix Contact controller. 

The document is aimed at experienced PC Worx users. It does not cover a complete 

project, just specific features associated with the use of Axioline E devices.

It is assumed the user has knowledge and experience in the operation of PCs and Windows 

operating systems, knowledge of the PC Worx software from Phoenix Contact and Ethernet 

basics.

1.2 System requirements

1.2.1 Software requirements

The information refers to firmware Version v2.0.0.0 of the IO-Link devices.

1.2.2 Hardware requirements for PC Worx

Please refer to the PC Worx documentation for the hardware requirements. 

1.2.3 Axioline E PROFINET IO-Link devices

The document is valid for the following Axioline E PROFINET IO-Link devices:

Designation Order 

No.

DeviceID ModulidentNumber Firmware

AXL E PN IOL8 DI4 M12 6P 2701513 0x0104 0x500000 v2.0.0.0 

or later

AXL E PN IOL8 DI4 M12 6M 2701519 0x0104 0x510000 v2.0.0.0 

or later
106657_en_00 PHOENIX CONTACT 5
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1.3 Example network configuration

This example project consists of a Phoenix Contact PROFINET controller, the AXL E-

PROFINET IO-Link device, and a PC with PC Worx. 

There may be an optional Ethernet switch in your configuration if your controller only has 

one Ethernet port.

The example system is shown in Figure 1-1.
.

Figure 1-1 Example system

1.4 General startup steps

Proceed as follows to start up Axioline E PROFINET IO-Link devices:

• Install the devices and connect the power supply.

• Create a new project in the engineering tool.

• Add the controller and I/O devices to the project.

• Enter addresses/names.

• Compile the project and send it to the controller.

• Establish communication with the I/O device and test this.
6 PHOENIX CONTACT 106657_en_00
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2 Creating a PC Worx project

To integrate the Axioline E devices into the network, proceed according to the 

documentation for your Phoenix Contact controller. This section only explains fundamental 

steps that are relevant to the Axioline E system.

2.1 Creating/opening a project

Perform the following steps to create a new project in PC Worx:

• In the menu bar, click on “File” and select “New Project”.

• Alternatively, you can use the “Ctrl + N” key combination.

Figure 2-1 Creating a new project

• The “New Project” window opens.

• Select your controller, in this example it is ILC 350 PN (1).

• Click “OK” (2).

Figure 2-2 Selecting the controller

It is assumed that the IP address of the controller is known and that a connection can be 

established. For further information, please refer to the user manual for the associated 

controller.
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All of the relevant data is then automatically added to the project tree.

Figure 2-3 Project tree
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2.2 Establishing a connection to the controller

The Phoenix Contact ILC 350 PN Inline controller is used in this example. The following 

steps apply specifically to this controller. Please perform the steps required for your 

controller according to the associated documentation.

• Click the “Bus configuration” button in the tool bar.

Figure 2-4 Clicking the “Bus configuration” button

The following view appears:

• Select your controller on the left in the “Bus Structure” window.

• In the right-hand window “Device Details”, enter the DNS name, MAC address, and IP 

address for your controller in the “IP Settings” tab.

Figure 2-5 Selecting the controller, entering the DNS name, MAC and IP address

It is assumed that the IP address of the controller is known.
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• Then use the “Communication” tab to test the set parameters.

• To do so, click “Test”.

Figure 2-6 Testing parameters

For starting up the controller and assigning the IP address, refer to the appropriate user 

manual.
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2.3 Adding PROFINET devices to the project

There are two ways of adding I/O devices to the project using PC Worx.

– In online mode: by reading in the PROFINET network

– In offline mode: by adding the device manually from the device catalog

2.3.1 Reading in a PROFINET device online

PC Worx allows you to read in the PROFINET network online. This enables you to transfer 

devices available in the network directly into the project.

To do so, carry out the following steps:

• Click the “Bus configuration” button in the tool bar. 

Figure 2-7 Clicking the “Bus configuration” button

• Right-click on “PROFINET” and select the “Read PROFINET...” menu item.

Figure 2-8 Selecting the “Read PROFINET...” menu item

A new “Read PROFINET” window appears in which all devices available online are 

displayed.

• Select your connected AXL E PROFINET device (1).
106657_en_00 PHOENIX CONTACT 11
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• Then click “Insert” (2).

Figure 2-9 Inserting a device

The “Select PROFINET device description” window opens.

Figure 2-10 Selecting the PROFINET device description

• Select your device type and then click “OK”.

• Close the “Read PROFINET” window.

Make sure that you have configured a network card for PROFINET communication via 

“Extras > PROFINET Configuration ...”.

The device type must be selected due to the fact that all AXL E-PROFINET 

devices share a single GSDML/FDCML file and therefore also have the same 

device ID.
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2.3.2 Adding a PROFINET device offline

As well as the ability to read in PROFINET devices online, PC Worx also allows you to add 

devices to the project from the device catalog in offline mode.

To do so, carry out the following steps:

• • Click the “Bus configuration” button in the tool bar. 

Figure 2-11 Bus configuration

• In the device catalog, select the Axioline E PN device “Phoenix Contact > AXL E > IO-

Link Master”.

• Move the selected device to the bus structure, directly next to the word PROFINET, 

using “drag and drop”.

• Release it as soon as the mouse pointer symbol changes next to the word 

“PROFINET”.

Figure 2-12 Selecting the device and dragging it into the bus structure

If you cannot find the “Device Catalog” window in PC Worx, you can activate it via 

the menu bar “View > Device Catalog”.
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3 Setting Axioline E PROFINET IO-Link device 

The Axioline E PROFINET IO-Link device is modular. Slot 1 always contains the 

“Status/Control Module” with four bytes of input and four bytes of output process data. 

In slots 2 to 9, both the operating mode and the process data length for the respective IO-

Link port are parameterized. In the default state, these slots are pre-allocated the “digital 

input” mode. 

The PROFINET device model of an AXL E PN IOL8 DI4 M12 6M is shown as an example.

Figure 3-1 PROFINET device model

The following sections describe all the necessary configuration options for the device.

For further information about the individual operating modes and configuration 

options, please refer to the device-specific data sheet.
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3.1 Performing a flash test

If you want to start up several Axioline E PROFINET devices of the same type, but do not 

have unique identification, you can uniquely identify these by carrying out a flash test 

directly on the device.

The PC Worx engineering tool can search all devices located/accessible on the PROFINET 

network and perform a flash test. This does not need to be available in the created project.

To do so, carry out the following steps:

• Click the “Bus configuration” button in the tool bar. 

Figure 3-2 Clicking the “Bus configuration” button

• Right-click on “PROFINET” and select the “Read PROFINET...” menu item.

Figure 3-3 Selecting the “Read PROFINET...” menu item

A new “Read PROFINET” window appears.
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• Select the device to be flashed (1).

• Click “Flashing On” (2).

Figure 3-4 Starting the flash test

The window changes and an icon (1) indicates which device is currently flashing. 

• You can terminate this function by clicking “Flashing Off” (2).

Figure 3-5 Terminating the flash test

On Axioline E PROFINET devices the BF and SF LEDs flash red simultaneously.
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3.2 Performing the IO-Link port configuration

A port configuration for slots 2 to 9 which configures the operating mode and the process 

data length for the relevant IO-Link port is required for the Axioline E PROFINET IO-Link 

devices.

Due to the PROFINET specification, port 1 (X01) only starts at slot 2, i.e., all port numbers 

are offset by one. Please note that the port configuration in engineering must also 

correspond to the actual configuration on the device, otherwise it will not be possible to carry 

out a correct upload.

To configure the ports, carry out the following steps:

• Click the “Bus configuration” button in the tool bar.

Figure 3-6 Clicking the “Bus configuration” button

In the default state, these slots are pre-allocated the “digital input” mode.
18 PHOENIX CONTACT 106657_en_00
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In order for the ports to be freely configured, all the default port settings are deleted in this 

example.

Figure 3-7 Deleting the default port settings

• To do so, click on the last slot 9 and then press the delete key.

• Repeat this for all ports up to port 2.

• Alternatively, you can right-click on the port in question and select the “Delete” option.
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Your configuration should then look like this:

Figure 3-8 Port configuration

• Now open the module catalog via “View > Module Catalog”.

Figure 3-9 Opening the module catalog
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• Then click on slot 1 “IO-Link Master x” of your previously inserted device in the bus 

structure.

Figure 3-10 Selecting the IO-Link master

• Insert the available submodules (operating modes) of the IO-Link master “Phoenix 

Contact > MODULE > AXL E > …” into the configuration from the module catalog by 

double-clicking on them one after the other. Alternatively, you can also do this via drag 

and drop. 

Figure 3-11 Inserting submodules
106657_en_00 PHOENIX CONTACT 21
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Making changes to the port configuration

If you want to make changes to the port configuration, you can use the PC Worx “replace 

function” 

• Select the required operating mode from the module catalog. 

• Right-click and select the “Copy Module” option (or press ctrl + C).

Figure 3-12 Changing the port configuration

• Then click on the port you want to change.

• Right-click and select the “Replace” option. 

The port then changes the operating mode.
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3.3 Setting IO-Link device identification 

The Axioline E PROFINET IO-Link masters support recognition and calibration of 

connected IO-Link devices. The vendor ID and the device ID can be set for each port. 

To set the device ID perform the following steps:

• Click the “Bus configuration” button in the tool bar.

Figure 3-13 Clicking the “Bus configuration” button

• Configure the ports according to section “Performing the IO-Link port configuration” on 

page 18.

• Switch over the ports, for which device identification should be performed, to IO-Link 

operating mode. 

The port configuration can appear as follows, for instance:

Figure 3-14 Example port configuration

As soon as the contents of the vendor ID and/or device ID do not equal “0”, the “Type 

Compatible” IO-Link inspection level is activated. It is only when both the parameterized 

vendor ID and device ID match the IDs that are read (in the device) that communication is 

established with the device (COM state bit of the corresponding port = 1), otherwise this 

is rejected (red IO-Link LED on). 
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• Double-click on the IO-Link port to be configured, port 5 or submodule 6 in this case.

• Switch to the “Device parameters” (1) tab.

• Select the “Device Validation” menu item (2).

Figure 3-15 Clicking the “Device Validation” menu item

Using the example of a capacitive sensor KQ6005 from ifm, the following settings are 

required: vendor ID 310d (01 36 h) and device ID 371d (00 01 73 h).

Figure 3-16 Example settings

In the “Value” field, enter the decimal values, i.e., you must convert every hexadecimal 

byte to decimal in advance and enter it in the corresponding field, in this example:

Vendor ID: 01hex = 1dec; 36hex = 54dec 

Device ID: 00hex = 0dec; 01hex = 1dec; 73hex = 115dec 
24 PHOENIX CONTACT 106657_en_00
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3.4 Setting the IO-Link data storage mechanism 

(parameter server)

The Axioline E PROFINET IO-Link masters support the data storage mechanism, which 

enables parameters to be exchanged between the master and device. 

The options are as follows: 

– Deactivated 

– Download Only 

– Upload Only 

– Download/Upload Allowed 

– Cleared 

To set the data storage mechanism perform the following steps:

• Click the “Bus configuration” button in the tool bar.

Figure 3-17 Clicking the “Bus configuration” button

• Configure the ports according to section “Performing the IO-Link port configuration” on 

page 18. 

• Switch over the ports, for which device identification should be performed, to IO-Link 

operating mode. 

Connected devices must support at least IO-Link specification v1.1 in order to use the 

function. 

For further information about the individual functions, please refer to the device-specific 

data sheet. 
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The port configuration can appear as follows, for instance:

Figure 3-18 Example port configuration

• Double-click on the IO-Link port to be configured, port 5 or submodule 6 in this case.

• Switch to the “Device parameters” (1) tab.

• Select the “Device Storage” menu item (2).

Figure 3-19 Clicking the “Data Storage” menu item
26 PHOENIX CONTACT 106657_en_00
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In order for the data storage mechanism to work, you should carry out the following steps:

Use of “Upload only” > “Download only”

1 Connect a fully parameterized IO-Link device to the appropriate port.

2 Configure the port to “Upload only”.

3 Download the program and switch the controller to online mode.

– The parameters are now read by the device and stored in the master on the port.

4 The device can now be swapped with a new device.

5 Re-parameterize the port to “Download only”.

6 Download the program and switch the controller to online mode.

7 The parameters are transferred as soon as the master is started and the device has 

been detected.

Use of “Download/Upload allowed”

1 Connect a fully parameterized IO-Link device to the appropriate port.

2 Configure the port to “Download/Upload allowed”.

3 Download the program and switch the controller to online mode.

– The parameters are now read by the device and stored in the master on the port.

4 The device can now be swapped with a new device.

– The parameters are written to the device from the master.
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3.5 Setting failsafe behavior

If PROFINET communication fails, all device outputs are set to the parameterized 

replacement values. The Axioline E PROFINET IO-Link device has a modular design, i.e., 

the operating mode can be flexibly set for each port. The higher-level failsafe behavior of the 

ports can be set via slot 1 Status/Control Module. 

Proceed as follows:

• Select the “Status/Control Module” (1) in the bus structure.

• Select the “Device parameters” (2) tab.

• Click on the “Failsafe (3) menu item.

Figure 3-20 Setting failsafe behavior
28 PHOENIX CONTACT 106657_en_00
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3.5.1 Ports in “digital output” mode

If there are ports with “Digital output” mode in your configuration, the failsafe behavior can 

be set via the following parameters.

Behavior in the event of an error for status/control module

– Sets the global behavior for all ports in “digital output” mode

Replacement values for DO 

– The behavior for each port can be set using the failsafe pattern.

– This only applies if “Replacement values” is selected in the previous parameter.

Figure 3-21 Setting failsafe behavior

Example: setting the failsafe pattern

Port 2, 5, and 8 work in “digital output” mode and should be set in the event of an error.

If the bit pattern is converted to decimal, this results in a value of 146. 

• Enter this value into the “Failsafe behavior DO” parameter in order to set the desired 

behavior.

Port 1 2 3 4 5 6 7 8

Bit 0 1 2 3 4 5 6 7

Replaceme

nt value

0 1 0 0 1 0 0 1

For additional information, refer to the device-specific data sheet.
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3.5.2 Ports in the “IO-Link” mode

If there are ports with IO-Link or AXL E IOL … mode in your configuration, the failsafe 

behavior can be set via the “Failsafe Behavior of Port X” parameter.

By default, “IO-Link Master Command” is set for the ports. The “IO-Link Master Command” 

option enables the use of IO-Link-specific mechanisms for valid/invalid OUT process data. 

Therefore the IO-Link device itself determines which failsafe behavior should be used.

Alternatively, the Axioline E PROFINET IO-Link can also specify the failsafe behavior. The 

following options are available.

– Clear all

– Set all

– Hold last value

Figure 3-22 Setting failsafe behavior via the “Failsafe Behavior for Port X” parameter

For additional information, refer to the device-specific data sheet.
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3.5.3 Assigning PROFINET device names

PROFINET uses names to address the devices.

Naming conventions for PROFINET device names:

– Limited to 127 characters (letters, numbers, dash, dot).

– A name component within the device name, i.e., a character string between two points, 

may be a maximum of 63 characters long.

– No special characters such as umlauts, brackets, underscore, slash, space, etc. A 

dash is the only special character permitted.

– The device name must not start or end with “-” or “.” characters.

– The device name must not start with numbers.

– The device name must not start with the character string “port-xyz-” (x, y, z = 0 ... 9).

– The device name must not take the form n.n.n.n (n = 0 ... 999).

Carry out the following steps to assign the name:

• Click the “Bus configuration” button in the tool bar.

Figure 3-23 Clicking the “Bus configuration” button

Make sure that the device name only occurs once in the PROFINET network. 

Observe the naming conventions listed below when assigning the device name.
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Then select your AXL E PROFINET device in the bus structure.

Figure 3-24 PROFINET Settings

• In the right-hand window “Device Details”, enter the DNS name, IP address, and 

standard gateway in the “PROFINET Settings” tab.
32 PHOENIX CONTACT 106657_en_00

DOWNLOADED FROM WWW.SCATTS.CO.UK



Setting Axioline E PROFINET IO-Link device

DOWNLOADED FROM WWW.SCATTS.CO.UK
• Then click on the “PROFINET Stationnames” tab (1).

• Select the device and click on the “Assign Name” (2) and “Assign IP” (3) buttons.

Figure 3-25 Assigning the device name and IP address
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3.6 Reading information & maintenance data records 

with Diag+ 

The Axioline E PROFINET device supports Identification & Maintenance functions (I&M). 

I&M data records are online data which is read from the device, i.e. your station must be 

operational. 

This I&M information is read out in PC Worx via Diag+.

To do so, carry out the following steps:

• Click the “Working area diagnostics” button in the tool bar.

Figure 3-26 Selecting the “Working area diagnostics” button

• Under “Communication Path” select “PC WORX” (1). 

• Under “Device Representation”, select “PROFINET IO Devices” (2) next to “Device 

Type”. 

• Then click “Connect” (3).

Figure 3-27 Selecting PC Worx and device

For additional information about I&M functions, refer to the device-specific data 

sheet.
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• In the “View” drop-down menu, select “PROFINET Diagnostic”.

Figure 3-28 Selecting PROFINET Diagnostic

• Then select the connected Axioline E PROFINET device (1). 

• Under “PROFINET IO Device” (2) you can see the I&M data of the connected device.

Figure 3-29 I&M data
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3.7 Reading diagnostic alarms and IO-Link device 

events (Diag+)

The Axioline E PROFINET device supports diagnostic alarms. These are saved to the 

device and the PROFINET controller is informed via incoming and outgoing diagnostics.

The diagnostic alarms are read out in PC Worx via Diag+.

In order to read out the diagnostic alarms, perform the following steps:

• Click the “Working area diagnostics” button in the tool bar.

Figure 3-30 Clicking the “Working area diagnostics” button

• Under “Communication Path” select “PC WORX” (1). 

• Under “Device Representation”, select “PROFINET IO Devices” (2) next to “Device 

Type”. 

• Then click “Connect” (3).

Figure 3-31 Selecting PC Worx and device

For a list of supported alarms and additional information, refer to the device-

specific data sheet.
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• In the “View” drop-down menu, select “PROFINET Diagnostic”.

Figure 3-32 Selecting PROFINET Diagnostic
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• Then select the connected Axioline E PROFINET device (1). 

• Under “PROFINET IO Device” (2) you can see the diagnostics of the connected device.

Figure 3-33 Diagnostics indicators
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4 Starting up a PC Worx project

4.1 Creating and linking variables

In this section, you will learn how to create variables in PC Worx and link them with real 

addresses.

Carry out the following steps:

• Click the “Process Data Assignment” button in the tool bar.

Figure 4-1 Clicking the “Process Data Assignment” button

In this example, the variables are automatically created. For other methods of creating 

variables and further information, please refer to the PC Worx documentation.
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The new process data view is structured as follows:

– Bus structure (1)

– Process data for the selected device (2)

– The variables stored in the project (3, 4).

Figure 4-2 Process data view

To create variables automatically, perform the following steps:

• Select the relevant AXL E PN device in (1).

• Then navigate in (3) to

“STD_CNF : ARM_L_40 > STD_RES : ILC350PN_395”.

• Next, select the required input/output (3) in (2) and move this to the window on the left 

(4) using drag and drop. 

• Do this for all the required variables.
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Alternatively, you can right-click on the output in question to open the context menu and 

create the variable by clicking “Create Variable”.

Figure 4-3 Creating a variable by right-clicking
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4.2 Compiling and building a project

Each time a new project is created or a change is made, the project must first be compiled 

and built. 

To do so, carry out the following steps:

• Click the “Create new project” button in the tool bar.

Figure 4-4 Clicking the “Create new project” button

PC Worx then compiles the entire project and displays the status in the message window at 

the bottom of the screen in the form of error messages and warnings.

Figure 4-5 Error messages and warnings

In the event of further program changes within the project, provided the hardware structure 

has not changed, it is sufficient to click on the neighboring “Make” object to recompile the 

project.

Observe the error messages and warnings displayed. 

By changing tab you can call up additional information about the individual error messages 

and warnings.
42 PHOENIX CONTACT 106657_en_00

DOWNLOADED FROM WWW.SCATTS.CO.UK



Starting up a PC Worx project

DOWNLOADED FROM WWW.SCATTS.CO.UK
4.3 Sending and starting a project

If the project could be built without errors, it can be sent to the controller and started.

To do so, carry out the following steps:

• Click on the “Project control dialog” button in the tool bar.

Figure 4-6 Clicking the “Project control dialog” button

A new window then opens which displays the current controller state and options for 

sending and starting the project as well as additional actions.

Figure 4-7 Sending and starting the project 

• Click on the “Download” (1) button to load the current project into the controller's 

memory.

• Then start the controller and therefore the application by clicking on the “Cold” (2) 

button. 

If the controller is in the “Run” state, a warning appears when you click on the “Download” 

button to indicate that the controller needs to be stopped before the project can be sent.

If the AXL E PN device cannot be reached and the BF LED lights up, perform a voltage 

reset.
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4.4 Testing the communication

The “Debug and force” function from PC Worx is used to show you how to read inputs or 

write outputs by means of an example. 

4.4.1 Reading digital inputs

On the Axioline E PROFINET IO-Link device, the process data of the hard-wired inputs and 

also the IO-Link ports in “digital input” operating state is in the “Status/Control Module”. This 

can be found on process data item “X0N Pin X DI state (C/Q)”.

Figure 4-8 Process data

Carry out the following steps:

• Click the “Process Data Assignment” button in the tool bar.

Figure 4-9 Clicking the “Process Data Assignment” button

The inputs now need to be linked with variables or automatically created.

• To do so, perform the steps described in section “Creating and linking variables” on 

page 39. 
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In this example, the variables for ports 1 and 7, which are configured as “digital inputs” and 

the hard-wired input on port 2, have been automatically created.

Figure 4-10 Variables

• Compile the project by clicking the “Create new project” button in the tool bar.

Figure 4-11 Clicking the “Create new project” button

• Then switch to the “IEC programming” area.

Figure 4-12 Clicking the “IEC programming” button
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Navigate to the variable list for Main via “Physical Hardware > STD_CNF : ARM_L_40 > 

STD_RES : ILC350PN_395 > Global_Variables” 

Figure 4-13 Variable list

• Click on the “Project control dialog” button in the tool bar.

Figure 4-14 Clicking the “Project control dialog” button

The path may differ depending on your controller.
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• Send the project to the controller (1) and start it by clicking “Cold” (2)

Figure 4-15 Sending and starting the project 

• Activate debug mode by clicking “Debug on/off” in the tool bar.

Figure 4-16 Clicking “Debug mode”

This provides you with an overview of the current values.

Figure 4-17 Variable values

In this example, the hard-wired input 2 is set, as indicated by the activated variable.
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4.4.2 Writing digital outputs

On the Axioline E PROFINET IO-Link device, the process data of the IO-Link ports in “digital 

output” operating state is in the “Status/Control Module”. This can be found on process data 

item “X0N Pin 4 DO state (C/Q)”.

Figure 4-18 Process data

• Carry out the following steps to write process data or outputs:

• Click the “Process Data Assignment” button in the tool bar.

Figure 4-19 Clicking the “Process Data Assignment” button

The outputs now need to be linked with variables or automatically created.

• To do so, perform the steps described in section “Creating and linking variables” on 

page 39. 

In this example, variables for ports 2 and 6, which are configured as “digital outputs”, have 

been automatically created.

Figure 4-20 Variables
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• Compile the project by clicking the “Create new project” button in the tool bar.

Figure 4-21 Clicking the “Create new project” button

• Then switch to the “IEC programming” area.

Figure 4-22 Clicking the “IEC programming” button
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Navigate to the variable list for Main via “Physical Hardware > STD_CNF : ARM_L_40 > 

STD_RES : ILC350PN_395 > Global_Variables” 

Figure 4-23 Variable list

• Click on the “Project control dialog” button in the tool bar.

Figure 4-24 Clicking the “Project control dialog” button

The path may differ depending on your controller.
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• Send the project to the controller (1) and start it by clicking “Cold” (2)

Figure 4-25 Sending and starting the project 

• Activate debug mode by clicking “Debug on/off” in the tool bar.

Figure 4-26 Debug mode

This provides you with an overview of the current values.

Figure 4-27 Variable values
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• To set or “force” outputs, right-click (1) on the relevant output variable.

• Select the “Debug dialog …” (2) option.

Figure 4-28 Selecting the “Debug dialog”

• In the window that opens, set the state of the output to “TRUE” or “FALSE” (1) in the 

“Value” field. 

• Then set the output via the “Force” button (2). The window closes automatically.

The forced value appears in your variable list in the “Online value” column with a red 

background color.

Figure 4-29 Variable list 

Once all the required I/Os have been tested, reset the forced outputs by clicking the “Reset 

Force List” button in the “Debug dialog” window.
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4.4.3 Reading/writing IO-Link process data

You can also use the debug or force function for test purposes to read the process data of 

the connected IO-Link devices or to transmit data.

The process data is mapped according to the IO-Link master configuration. Unique 

assignment is possible using the device name and the slot number 

In this example, the following IO-Link master configuration is used, the corresponding 

process data for the individual slots can be seen in the following illustration on the right.

Figure 4-30 Process data for the individual slots

The necessary steps for reading and writing IO-Link process data for test purposes can be 

found in section “Reading digital inputs” on page 44 and “Writing digital outputs” on 

page 48. 
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5 Using the PC Worx IOL_COM function block

5.1 Basics

The Axioline E PROFINET IO-Link device supports the Phoenix Contact PC Worx 

IOL_COM function block.  

The function block helps to make it possible to write data to an IO-Link device or read data 

from an IO-Link device. To do so, the IO-Link protocol uses ISDU objects (Index Service 

Data Unit). These have an index and a sub index. For a description of the ISDU objects 

supported by a device, please refer to the specific data sheet of the IO-Link device.

• Navigate to “Home > Service and Support > Downloads > Function blocks > Free 

function blocks for PC Worx".

• Download the “Function modules” function block library. This library contains the 

IOL_COM function block.

5.2 Prerequisites

You should have an executable project and observe the following points:

– The FDCML file of the Axioline E PROFINET IO-Link devices is installed in PC Worx.

– A connection can be established with the controller and the IO-Link device.

– The IOL_COM function block has been imported into PC Worx.

The IOL_COM function block is only required if your IO-Link device has ISDU objects and 

you want to read or write these or read diagnostics information. Otherwise, the process 

data communication is sufficient.

The IOL_COM function block must be downloaded separately from the Phoenix Contact 

homepage and imported into PC Worx. 

The “AsynCom_PN_V1_XX_X” function module must also be inserted into the project to 

enable asynchronous communication with PROFINET devices. This is supplied with the 

setup. 

Normally, this is automatically installed with PC Worx. If this is not the case, then you must 

have an old version of PC Worx. In this case, cannot guarantee that this will work with the 

Axioline E device and the block. Please contact support. 
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5.3 Installing the function block

• Start the installation by double-clicking the EXE file and then follow the installation 

instructions.

Figure 5-1 Starting the installation

• Complete the installation by clicking “Finish”.

Figure 5-2 Completing installation

It is assumed that you have already downloaded the block or the EXE file

(in this case: pc_worx_6_x_functionmodules_1_13.exe) and saved it on your PC.
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5.4 Porting the function block to the PC Worx version 

in use

Before you can use the function block in PC Worx, this must be ported to the version you 

are using, as the function block may have been created in an older version of PC Worx. To 

do so, carry out the following steps:

• Select “File > Open Project / Unzip Project” 

(or ctrl + O).

Figure 5-3 Opening a project

• Then navigate to the folder in which the function block was installed. This is normally 

“C:\PC WORX 6.x\Libraries\FunctionModules_1_13”.

• Select the “FunctionModules_V1_13.mwt” file.

• Click “Open”.

Figure 5-4 Selecting the “FunctionModules_V1_13.mwt” file

It is assumed that you have already installed the block 

(pc_worx_6_x_functionmodules_1_13.exe). 
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• Answer the following warnings with “Yes”.

Figure 5-5 Converting a project

The function block is now loaded as an independent project. 

Figure 5-6 Function block as an independent project
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• Finally, recompile the project by clicking the “Create new project” button in the tool bar. 

Figure 5-7 Clicking the “Create new project” button

The function block has now been ported to the version of PC Worx in use.  
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5.5 Inserting a function block into your project

Once you have carried out the steps in the previous section, the function block has been 

ported for the version of PC Worx that you are using and can be used.

To use the function block in your actual project, the following steps must be carried out.

• In the menu bar, select “Project > Add Library > User Library ...”.

Figure 5-8 Selecting the user library

• Then navigate to the folder in which the function block was installed. This is normally 

“C:\PC WORX 6.x\Libraries\FunctionModules_1_13”.

• Select the “FunctionModules_V1_13.mwt” file.

• Click “Include”.

Figure 5-9 Selecting the “FunctionModules_V1_13.mwt” file
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This loads the function block library into your project and it appears in the project tree under 

“Libraries”.

Figure 5-10 Function block in the project tree

The IOL_COM function block can be found in the Edit Wizard under the name 

“IOL_COM_V1_XX”. 

• Add the function block to your main program via drag and drop.

Figure 5-11 Inserting the function block
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• You must also insert the “AsynCom_PN_V1_XX_X” function block into the project to 

enable asynchronous communication with PROFINET devices.

Figure 5-12 Inserting function block “AsynCom_PN_V1_XX”

• Then add the corresponding variable for each input/output. You can do this by right-

clicking on the input/output and selecting the “Variable...” entry.

Figure 5-13 Inserting variables

The udtAsynCom structure of the function block must be connected to the IOL_COM 

system block. If multiple AsynCom_PN blocks are used in the same PROFINET 

environment, it must be ensured that the same variable is used for all these AsynCom_PN 

blocks. 
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5.6 IOL_COM parameter description

The function block is structured as follows. 

Function block Variable Description

xActivate "True: block activation

"False: block deactivation

xReset The block is reset on a rising edge and communication is re-

initialized.

xPNIO_Data_Valid Status bit for the evaluation of a valid PROFINET connection 

(optional).

xTrigger An IO-Link service is read or written with a positive edge.

xRead_Write True = write access

False = read access

iPort Number of port on which to read or write

0: IO-Link master

1..8: port number

wIndex Index of the IOL object to be accessed

bSubIndex Subindex of the IOL object

iWriteLength Number of bytes to be written

arrIOL_ReadData The array contains the received data. Every successful read 

access will overwrite the data in this array with the newly 

received data.

arrIOL_WriteData The array contains the data to be written.

udtAsynCom Structure for the communication with the function block of the 

AsynCom library.

xActive True: the block is initialized without errors and running.

False: the block is not ready to operate.

xDone True: service has been successfully written/read. The 

parameter is True as long as xTrigger is True (for at least one 

cycle).

xBusy True: the block is busy with the service execution. False: block 

is ready for the next access.

xError This parameter indicates an error. The error message can be 

deleted by deactivating/re-initializing the block.

wDiagCode Diagnostic code

dwAddDiagCode Advanced diagnostic code

iReadLength Number of bytes received

The assigned variable must be the same for 

both for IOL_COM and the AsynCom_PN block
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For further information, please refer to the documentation for the block or the help function.

You can open this by right-clicking on the block and selecting “Help for FB/FU”.
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5.7 IOL_COM error codes (wDiagCode)

The “xError” variable contains the value 0 if the data transfer was completed without errors. 

If errors occur during transfer, the “wDiagCode” and “dwAddDiagCode” variable contain the 

relevant diagnostic codes for aid troubleshooting.

The following diagnostics codes are possible:

DiagCode Description

0000hex Block is not active.

8000hex Block is active and operating without errors.

C100hex Communication error

AddDiagCode Meaning

00000000hex PROFINET connection timeout or error. The parameter PNIO_Data_Valid 

(optional) is False.

00000010hex Invalid communication reference, e.g., strPartner is zero.

09B00005hex There is no communication reference.

xxxxxxxxhex Communication error (error from PCP_CONNECT firmware block, see firmware 

block description in PC Worx)

C200hex Configuration error

AddDiagCode Meaning

00000001hex Invalid parameter at the iWriteLength input

C300hex IO-Link error

AddDiagCode Meaning

xxxxxxxxhex The parameter is structured as follows:

WORD 1 WORD 0

Byte 1 Byte 0

IOL_M Error_Code IOL Error_Code IOL Add_Error_Code

The meaning of this diagnostic information is described in the IO-Link 

specification. 

C400hex Error during Send service

AddDiagCode Meaning

xxxxxxxxhex Error from WRREC or PCP-Write firmware block, see firmware block description 

in PC Worx

DF80A1xxhex Negative acknowledgement when writing to the module:

cause: incorrect service content, index, subindex, incorrect port number or length 

of the data to be written

0000F003hex Invalid node ID

0000F016hex The service used to write the RECORD data record could not be run.

06050000hex Invalid length of the data to be written.

06070000hex Invalid index
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5.8 AsynCom_PN parameter description

The function block is structured as follows. 

C500hex Error during Read service

AddDiagCode Meaning

xxxxxxxxhex Error from RDREC or PCP-Read firmware block, see firmware block description 

in PC Worx

DE80A0xxhex Negative acknowledgement when reading the module:

cause: incorrect service content, index, subindex or incorrect port number

0000F003hex Invalid node ID

0000F015hex The service used to read the RECORD data record could not be run.

06070000hex Invalid index

DiagCode Description

Function block Variable Description

dwNodeID Device communication error

udtAsynCom Communication structure

xBusy The variable is true, as long as a communication block 

transmits or receives data.

dwDiagCodeConnect Error code with regard to the communication status

dwDiagCodeRead Error code with regard to the reading of objects

dwDiagCodeWrite Error code with regard to the writing of objects

On Axioline E, this is the node ID of the 
“status/control module” in the bus structure 
under the “Module Settings” tab.

The node ID is generated automatically by PC 

Worx and may therefore vary in the individual 

projects.

The assigned variable must be the same for 

both for IOL_COM and the AsynCom_PN block

For further information, please refer to the documentation for the block or the help function.

You can open this by right-clicking on the block and selecting “Help for FB/FU”.
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5.9 AsynCom_PN error codes (dwDiagCode…)

The errors codes are transferred to the IOL_COM function block output “wDiagCode”and 

can be understood using the table in section “IOL_COM error codes (wDiagCode)” on 

page 65.
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5.10 Reading IO-Link device parameters

In the case of read access (xRead_Write = 0), the data from the IO-Link device is stored in 

the array on the “arrIOL_ReadData” input and the number of read bytes is displayed at the 

“iReadLength” output. 

During data transfer, the “xBusy“ output = TRUE (1) as long as “xTrigger” = TRUE (1).

If data transfer is successful, the “xDone” output = TRUE (1),

“xError” = FALSE (0) and “wDiagCode” contains the value 16#8000.

In the event of an error, the “xError” output = TRUE (1) and the diagnostic information is 

output via the “wDiagCode” and “dwAddDiagCode” outputs.

5.10.1 Example: reading the order number of the AXL E IOL AO1 I 

M12 S device

The following structure is used in this example:

– The status/control module of the IO-Link master has node ID 50.

– The AXL E IOL AO1 I M12 S device is connected to port 3.

Figure 5-14 Status/control module of the IO-Link master

By referring to the data sheet for the AXL E IOL AO1 I M12 S device, you can determine that 

the ISDU object with index 13hex, decimal 19, contains the order number to be read.
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Perform the following steps to read the device order number:

• Make the following settings on the IOL_COM function block.

• Also enter the node ID of the status/control module into the “dwNodeID” input of the 

AsynCom_PN block, in this case 65.

Successful execution of the service should look as follows:

Figure 5-15 Online view of the configured function block

Parameters Description

xActivate = 1 (true)

xReset = 0 (false)

xPNIO_Data_Valid = 0 (false, optional use)

xTrigger = 1 (true)

xRead_Write = 0 (false, as read access)

iPort = 3

wIndex = 16#0013 (refer to the device data sheet for this)

bSubIndex = 16#00 (no subindex)

iWriteLength = 0 (as read access)

arrIOL_ReadData = Target array for the read data
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You can monitor the data of the “arrIOL_ReadData” array via the Watch Window.

• Right-click on the input (1). 

• Select “Add to Watch Window” (2) and then “Open Watch Window...” (3).

Figure 5-16 Opening Watch Window

In this example, the data appears as follows:

Figure 5-17 Online view of the order number

If these are converted from HEX to ASCII, entry [1] to [7], the result is: 2700351.
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5.11 Writing IO-Link device parameters

In the case of write access (xRead_Write = 1), the data from the array is read at the 

“arrIOL_WriteData” and transferred to the connected IO-Link device. The amount of data to 

be written is specified in the “iWriteLength” variable.

During data transfer, the “xBusy“ output = TRUE (1) as long as “xTrigger” = TRUE (1).

If data transfer is successful, the “xDone” output = TRUE (1), “xError” = FALSE (0) and 

“wDiagCode” contains the value 16#8000.

In the event of an error, the “xError” output = TRUE (1) and the diagnostic information is 

output via the “wDiagCode” and “dwAddDiagCode” outputs.

5.11.1 Example: writing the ParaWord of the AXL E IOL RTD1 M12 

S device

The following structure is used in this example:

• The status/control module of the IO-Link master has node ID 50.

• The AXL E IOL RTD1 M12 S device is connected to port 4.

Figure 5-18 Status/control module of the IO-Link master

By referring to the data sheet for the AXL E IOL RTD1 M12 S device, you can determine that 

the ISDU object with index 80hex, decimal 128, contains the parameter word (ParaWord) to 

be written.
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In this example, the format is to be changed to IB IL and the sensor type to linear R0 Ohm 

… 5k Ohm. The data to be written are therefore 002Fhex.

Perform the following steps to write the device order number:

• Make the following settings on the IOL_COM function block.

• Also enter the node ID of the status/control module into the “dwNodeID” input of the 

AsynCom_PN block, in this case 65.

You can enter the data of the “arrIOL_WriteData” array via the Watch Window.

• Right-click on the output (1). 

• Select “Add to Watch Window” (2) and then “Open Watch Window...” (3).

Figure 5-19 Opening Watch Window

Parameters Description

xActivate = 1 (true)

xReset = 0 (false)

xPNIO_Data_Valid = 0 (false, optional use)

xTrigger = 1 (true)

xRead_Write = 1 (true, as write access)

iPort = 4

wIndex = 16#0080 (refer to the device data sheet for this.)

bSubIndex = 16#00 (no subindex)

iWriteLength = 2 (ParaWord is 2 bytes in size)

arrIOL_WriteData = source array for the data to be written (002Fhex)
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• Next, you can write the data for each entry (array element) by right-clicking and select-

ing the debug dialog.

Figure 5-20 Opening the debug dialog
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